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Making Accessible Word Files  

This document is a guide to creating documents in 

Microsoft Word.  The author, Trevor Johnson-

Steigelman has made it available CC-BY-NC. 

Why Make Accessible Documents?  

Making documents accessible is important for 

many reasons.  The overriding reason is that you 

want your audience to be able to read and 

understand your document without additional 

effort.  The second reason is because of legal 

requirements written into the Americans with 

Disabilities Act (ADA) and other legislation. 

When you create your document so that it is 

accessible from the beginning, you do not need to 

revise it when you have a student who requires 

accommodation, or if you do, the revisions should 

be minor. 

As a side benefit, accessible documents are easier 

to read for all students.  It is also easier for you to 

move the information in an accessible document 

into other formats. 

Accessibility for All. 

Many of the accessibility recommendations help 

you meet the requirements of the ADA.  This 

includes specific groups like people with vision, 

hearing, and mobility impairments. 

However, there are other groups that can benefit 

from making documents accessible.  These include 

people with learning challenges like dyslexia or 

other reading disorders. 

Even people without any specific problems can 

benefit from documents that have been made 

accessible. For example, one of the most common 

accessibility fixes is to include headings to a 

document.  If you’ve every read a document or 

article that was just a wall of text, you can 

appreciate a well-placed heading.  

Features of  Accessible Documents.  
According to the Web Content Accessibility 

Guidelines (WCAG 2.0), online documents should 

be Perceivable, Operable, Understandable, and 

Robust.  Even though the guidelines are for web 

documents, your print and electronic documents 

should follow these guidelines too. 

When you create documents, it is very likely that 

you try to make them look “pretty”.  This is your 

attempt to make them perceivable and 

understandable.  Unfortunately, many of the things 

that we do, like using different fonts and placing 

images, can break the operable and robust parts of 

the guidelines. 

For example, for years I tried very hard to make 

the headings of my documents stand out from the 

rest of the body of the text by making them bold 

and maybe a bit larger.  I did this by directly 

adjusting the fonts.  This makes the headings stick 

out for a sighted reader.  They can skim through 

the document and easily see the headings. 

Unfortunately, bold, larger text doesn’t necessarily 

stick out to a screen reader or a braille reader. 

There are several things you can bake into your 

documents that will help students using a screen 

reader.  Fortunately, most of these things will help 

all students. 

The most common accessibility adjustments to 

your text documents are… 

• Choosing accessible fonts. 

• Careful use of color and contrast. 

• Using Heading tags. 

• List Styles. 

• Accessible Images - Alternative Text. 

• Establishing a precise reading order. 

• Using two columns. 

Microsoft Word makes most of these steps simple, 

and by making an accessible template, you won’t 

have to do the setup every single time.  I’ll review 

each of these items in the remainder of this 

document. 

The Accessibil ity Checker.  
The most recent versions of Microsoft Word include 

a feature called Accessibility Checker.  It is 

available under the Review Tab in the Ribbon. 

 

This means that you have a tool to relatively 

quickly check your document and fix any problems 

that might exist.  Remember to run the checker 

before you finish your document. 

If you have an existing document, this is a quick 

way to find out what things you can change to 

improve the accessibility.  One word of warning, 

though; chances are that there are many problems 

with accessibility.  The upside is that most of them 

are relatively easy to fix.  
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Using Accessible and Available Fonts .  
The fonts you use can have a huge effect on the 

accessibility of your documents.  You need to 

choose a font that is both easily readable and 

widely available. 

Choosing Accessible Fonts. 

These days, there are hundreds, if not thousands 

of fonts that are available to us.  While these fonts 

can add pizzazz to our documents, most of them 

will cause problems with accessibility. 

The accessibility problems come from the way that 

certain characters are depicted.  For example, 

capital “I” and lower case “l” and the number “1” 

could each be represented with a vertical line.  

This can cause decoding problems for certain 

individuals. 

Look at the characters in the following image.  It 

contains the name of the font followed by the 

number 1 and the word Illness, spelled with a 

capital I. 

 

Verdana is the recommended font for accessibility.  

Notice that the characters for the 1, I, and l are 

easily distinguishable. 

Compare this to the same characters for the Arial 

example.  In Arial font, the symbol for the capital I 

and the lowercase l are exactly the same.  Calibri 

font makes the upper case I slightly shorter, but it 

is still hard to tell the difference. 

These three fonts are all considered to be sans 

serif.  Serifs are the small bars and flourishes at 

the ends of letters.  Verdana breaks the “without 

serif” rule by adding the serifs to the capital letter 

I, making it easily distinguishable. 

Verdana also makes the font size a bit larger, even 

though the fonts in the image were all set to be 14 

pt.  Verdana puts a slight bit more space between 

characters as well.  These changes make it easier 

to read, and therefore the preferred sans serif font. 

The next image compares three serif fonts, 

Georgia, Times New Roman, and Cambria. 

 

Georgia is considered to be the most accessible of 

the three, even though the differences in 

readability between these three fonts is not as 

striking.  The number 1 is slightly more 

distinguishable in the Georgia font.  The Times 

New Roman number 1 and lower case “l” could be 

confused. 

Other, more ornate fonts are available, but you 

should generally avoid them.  The extra flourishes 

can be distracting for readers with dyslexia or 

other learning disabilities. 

Choosing Common Fonts. 

In addition to the readability of fonts, one should 

also consider the availability of fonts. 

These days, students could be reading your 

documents on a computer, in print, on a tablet, or 

even on a cell phone.  This means that you should 

use fonts that are readily available. 

Both Verdana and Georgia are considered to be 

“universal” fonts, meaning that they are available 

on most platforms. 

Have you have ever seen a person giving a 

PowerPoint presentation complain that the fonts 

aren’t right?  If so, chances are that they made the 

presentation on a different type of computer (Mac 

or PC) than the computer being used to present 

the talk.  It could also be the case that they 

downloaded a special font from the internet and 

forgot to embed it into the document. 

By using Verdana and Georgia, you make it more 

likely than not that the student will have the font 

on their local computer. 

This document is written using Verdana for the 

body, and Georgia for the headings and should 

appear the same wherever you read it. 

Applying Styles 

Styles are a way that Word allows you to quickly 

apply formatting throughout a document.  Within 

the home tab, there is a group called “Styles”, 

which includes Normal, Heading 1, Heading 2, and 

other styles. 

Start a paragraph, apply a font, and then right-

click on the Normal style in the ribbon.  A context 

menu will allow you to “Update style to match 

selection. 

If you apply fonts using the styles options, a 

student can easily change the styles to fit their 

tastes.  For example, there is a font called 

OpenDyslexic that a student could apply to their 

personal copy of your document.  
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Careful  Use of Color and Contrast  
Sometimes authors will try to be fancy with their 

headings and text, giving it different colors.  You 

need to be very careful of how you use color and 

contrast. 

Meaning through Color 

A helpful teacher might decide to make all of the 

new vocabulary words in a document bright orange 

so that students can easily find them. 

While the idea of using color is good, make sure 

that you don’t use color exclusively.  You might 

include a phrase like “a new vocabulary word”, “is 

defined as”, or something similar.  You could 

include a list of new words somewhere in the 

document.  Preferably, you’d do all of these things 

in the document. 

This is necessary because screen readers don’t 

register changes in color.  They may register bold 

or italics, but not all do.  Adding some color may 

be helpful but it doesn’t give semantic meaning or 

context to screen readers.  The “Read Aloud” 

function of Word doesn’t point out either bold or 

italics, even when a tag is applied. 

Also remember that most copiers are black and 

white.  Fancy use of color will be lost when you 

print it out on most printers. 

Don’t put tints behind text or highlight text for the 

same reasons.  Just because you see that done in 

textbooks doesn’t mean that it is a great idea. 

Grey Text. 

Several years ago, there was a move on web 

pages to avoid using dark text on white 

backgrounds.  The theory was that the difference 

in contrast between the white page and the black 

text was causing undue strain on readers’ eyes.  

This led to the use of grey text like this... 

 

I personally found this to be annoying and stopped 

reading websites that implemented this idea.  Let 

students adjust the contrast and brightness on 

their screens or change the color of the text on 

their own printout. 

Colorblindness. 

It is okay to use colorful text in your documents, 

but remember, there may be students who are 

colorblind in your class.  There are several different 

types of colorblindness. 

 

Image from reddit user luccyVeins, 

https://i.redd.it/c1c5u0dhret01.jpg. Based on work 

from https://www.color-blindness.com  

People with protanopia have trouble seeing 

differences between red and green.  Using green 

text for “good ideas” and red for “bad ideas” would 

be lost on students with this condition.  They would 

also have trouble telling the difference between 

pink and blue. 

People with tritanopia have trouble seeing 

differences between blue and yellow.  They can tell 

that red and green are different, but they can’t 

distinguish between blues and greens. 

For protanopia and tritanopia, highlighting some 

colors of text with certain colors will cause the text 

to disappear, blending foreground and background 

together. 

Very few people have monochromacy, seeing in 

black and white.  However, as mentioned earlier, 

most printers print in black and white and grey. 

The short story on color is to make sure that it 

isn’t the only way that you provide meaning in a 

document. 

  

https://i.redd.it/c1c5u0dhret01.jpg
https://www.color-blindness.com/
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Using Proper Heading Tags .  
Heading tags are a way to mark off different parts 

of your document.  By using the heading tags, you 

accomplish two things. 

The first is that you signal to screen readers where 

each section begins.  This allows a person using a 

screen reader to skim ahead in the document in 

the same way a sighted person might. 

The second useful function of heading tags is that 

you can apply formatting to the tags to keep your 

document consistent. 

Heading tags are part of the “Styles” options.  If 

you click on the home tab, you can see the 

“Styles” area of the ribbon.   

 

There are many styles available, but the important 

ones are the Title and the Headings.  The headings 

are labeled Heading 1, Heading 2, etc. 

The Title Style. 

The title should be reserved for the title of the 

paper, and only used once.  There is an option for 

a subtitle if you’d like to add one.  For some 

reason, Word doesn’t treat your title as the actual 

title of the document.  You can set the title of the 

document (as opposed to the file name) by clicking 

on the File tab in the ribbon.  To the right-hand 

side, you will see an area titled “Properties”. You 

can change the display title of the document here. 

Heading Tags. 

The headings form a hierarchy with Heading 1 

being the top-level heading.  Heading 2 could be 

considered a sub-heading of Heading 1.  Heading 3 

would be a sub-sub-heading.  However, the term 

“subheading” isn’t used in this context. 

You should be careful to nest your heading tags 

appropriately.  This simply means that you should 

make sure that each new top-level section starts 

with Heading 1, followed by Heading 2, and so on.  

Don’t skip headings.  For example, you should 

never go from Heading 1 directly to Heading 3. 

In most documents, you shouldn’t need to go 

beyond Heading 3, even though the headings can 

extend all the way down to Heading 9. 

The NVDA screen reader will jump to the next tag 

when you press the “H” key. 

Formatting the Tags. 

You can adapt the style of the heading tag to suit 

your tastes.  In fact, you probably will want to, 

since the default formatting of tags is not very 

pretty.  The default size of the fonts is too big in 

my opinion.  The spacing around the tags is weird 

too. 

The simplest way to do modify the appearance of 

the headings is to apply the heading to its first 

appearance in the document. 

Next, format the text of your heading, including 

font, font size, bold/italics, color, and spacing.   

Once it looks the way you want it to look, simply 

highlight the text. 

Next, right click on the style you want in the styles 

group on the home tab.  A context menu will 

appear that looks like this… 

 

Click on the first choice, “Update Heading X to 

Match Selection”.  (The X will be replaced by the 

number of the heading you have selected.) 

If any other occurrences of the heading appear, 

they will be automatically updated throughout the 

document. 

Other Benefits of Using Heading Tags. 

If you go to the “View” tab and click on the 

Navigation Pane option in the “Show” group, you 

can see a list of the headings in your document.  

This makes it easier for you to navigate through 

long documents.  If you make a table of contents, 

Word will use the heading tags to populate the 

table.  
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List Styles.  
Lists are a useful way to gather information 

succinctly.  However, you may find problems with 

some lists, unless you apply list tags carefully. 

Within Word, you can start a list by writing down 

the first item in the list, and then clicking on the 

“Bulleted List” style found on the Home tab in the 

aptly named “Styles Group”. 

• List item. 

• List item. 

• List item. 

You can get out of the list by pressing the enter 

key twice at the end of the list.  

Unfortunately, this keeps the indent of the 

list going on into the next paragraph, as 

you can see here. 

To get out of this indentation, click on the 

“Normal” style while your cursor is in the next 

paragraph. 

If you prefer numbered lists, use the “Numbered 

List” style. 

Why should you use the list styles? 

Using the list style automatically does two things.  

The first is that it will put a marker at the 

beginning of the list.  The second is that it will 

apply a hanging indent so that a list item that 

spans two lines of text will be indented properly. 

The third thing that the list styles will do is add 

context to the list.  Before reading the list, a 

screen reader will state that it is entering a list.  It 

will also let the listener know when the list includes 

different levels. 

Careful Use of Punctuation. 

The use of punctuation is something that is not 

often mentioned when you look up information 

about accessibility. 

We’ve been taught to write in complete sentences 

and to place periods, question marks, or 

exclamation points only at the end of sentences. 

Screen readers, like most people, use punctuation 

to know when to insert pauses when reading. 

Most people also know to pause at the end of the 

line of a bulleted list.  Screen readers may or may 

not know to do this.  For this reason, I put a period 

at the end of bullet list items, even if the item isn’t 

a complete sentence. 

I know that Mrs. Rapsey and Mr. Zakutney, my 

high-school English teachers might be 

disappointed.  In the past year or two, I have seen 

improvements, but I still recommend that you put 

a period at the end of each list item. 

You may notice that I put periods at the end of my 

headings too.  Again, this is to ensure that screen 

readers pause after reading the heading. 

Pitfalls of the list styles. 

Numbered lists can be a bit troublesome in Word 

sometimes.  For example, you might want to 

interrupt a list with a quick comment and then 

continue.  You might also have two separate lists 

close to each other in the document. 

I have found that there are about even chances of 

Word starting a new a list or continuing a list when 

I don’t want it to.  In these situations, right-click 

on the list and look for options to “Separate list” or 

“start numbering at…”, then fix the problem. 

Why even include lists? 

There is a whole list of reasons why you might 

want to make a list in your document. 

• You include lists to help summarize 

information. 

• Lists allow students to skim the text to find 

information.   

• You might have a list of materials for an 

experiment. 

• Breaking instructions into a list helps 

students do multi-step tasks. 

All of these are good practices.  Just make sure 

that you format your lists appropriately. 

Screen Readers and Lists 

Each screen reader has a different set of 

keystrokes to read lists. 

NVDA will jump to the next list if you click the “L” 

key from inside the document.  Within the list, you 

can click on the “I” key to move on to the next 

item in the list. 
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Accessible Images .  
By their very nature, images can contain large 

amounts of visual data.  Unfortunately, readers 

with limited vision can’t immediately process this 

information.  To make your images accessible, 

make use of the “alt-image” or “alt-text” feature. 

Alternative Text. 

Alternative text, or “alt text” for short, is text that 

is used to describe the image.  Screen readers will 

read this text in place of the image.  If there is a 

problem loading the image, the alt text will display 

instead.  Sometimes people familiar with posting 

images on the internet will refer to the alt-text as 

an “alt-tag” or simply “tag” instead. 

Including Alternative Text. 
To include alternative text on a picture in Office 

365 or later, right click on the image.  The context 

menu will include an option to “Edit Alt Text…” 

 

Clicking on this option will open the Alt Text dialog 

box on the right-hand side of the Word window. 

 

On older versions of Word, you use the 

accessibility checker, and it will guide you picture 

by picture through the document. 

There may be some text already generated for the 

image.  More often than not, though, this text is 

not what you want it to be.  For example, I often 

see “image from a cell phone” as the text.  The 

auto-generated alt-text for the picture of a golfer 

below was “a group of people playing baseball”. 

You write your text in the empty box.  If the 

picture is just decoration, click on the “Mark as 

decorative” box.  Screen readers might then ignore 

the image.  This depends on the sophistication of 

the screen reader. 

There is also an option to donate your picture for 

science.  This option lets Microsoft use your alt-

text to build a database of image descriptions that 

will use artificial intelligence to label pictures. 

Your alternative text should be a useful description 

of the image.  Don’t include “Picture of…” or similar 

words.  The screen reader will preface the alt-text 

with “image” before reading the alt-text. 

Next, we’ll talk about writing useful alt-text. 

Writing good alternative text. 
Writing alternative text is a bit of an art.  Think 

about the important part of the image and use that 

as the basis for creating your alt-text. 
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For example, the following picture of a golfer could 

be used in several different contexts. 

The image is from Keith Allison, a freelance 

photographer located in Baltimore, MD specializing 

in professional sports, and is used with a Creative 

Commons BY-SA license. 

 

The caption provided on flickr.com read… 

“Alexandra Casi earned her spot into the LPGA 

Kingsmill Championship in a 29-player qualifying 

event at the 6,384-yard River Course by shooting 

a three-under par 68. Williamsburg, VA April 30, 

2013.” 

If I were writing an article about Alexandra Casi, 

this caption might be just the thing that I would 

include as my alt-text. 

However, I would also probably include this 

information in the text of the article.  In that case, 

the alt-text might be simply “Alexandra Casi at the 

2013 LPGA Kingsmill Championship”. 

You should avoid being redundant with alt-text.  

I’ve found that writing alt-text for images in lab 

report handouts has helped me write better 

descriptions within the body of the report.  The 

important things I see in the pictures or diagrams 

should be described in the text for everyone to 

read (or hear). 

If I were using this image in an article about 

playing golf for fitness, the alt-text could be as 

simple as “female golfer”. 

Notice that I didn’t say that there were other 

people in the background in either description.  I 

didn’t mention trees in the background, the weird 

tripping hazard, the color of Alexandra’s jacket, or 

the expression on her face.  None of this 

information is important to the context of the 

picture.  (Of course, if you are talking about these 

things in the article, you would include them in the 

alt-text.) 

There is an excellent article about how one might 

write alternative text for a famous portrait of 

George Washington by Gilbert Stuart.  The article 

can be found at the Web Accessibility in Mind 

website at the following URL 

https://webaim.org/techniques/alttext/#context 

The whole article talks about images used on the 

internet, but the information about context also 

works for images in Word documents or 

PowerPoint presentations. 

Text-Heavy Images. 

If you have an infographic or other text-heavy 

image in your document, you should re-write the 

text on the image and include it in the body of the 

document.  Include text that describes how the 

information is organized. 

This might seem redundant, but remember, 

visually impaired students won’t be able to see the 

image, so they will be missing all of the 

information. 

Sighted students will benefit from seeing the text 

in both places or can simply skip the text or the 

image. 

  

https://webaim.org/techniques/alttext/#context
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Reading Order.  
One of the pitfalls of using images is reading order.  

We really want to make sure that the image fits in 

with the flow of the text. 

If you right click on an image, a small box with an 

upside down half circle will appear at the upper 

right-hand corner of the image.  Clicking on this 

symbol will bring up the “Layout Options” context 

menu. 

 

Word has two basic options for the placement of 

images.  The first option is to have the image 

appear “In Line with Text”.  The second option is 

“With Text Wrapping”.  Text wrapping allows the 

text of your document to flow around the image.  

You have several options related to text wrap, 

placing the image to the left, center, or right of the 

page.  If you really dislike your readers, you can 

even have it appear behind or on top of your text. 

The problem with having text wrap is that a screen 

reader won’t necessarily read the alternative text 

at the right time, unless you very carefully place 

your anchor.  (Notice the small anchor that 

appears at the lower left corner of the image.)  The 

other problem with text-wrap is that it is very 

prone to misbehaving.  I’ve had images suddenly 

move to different pages in the document. 

In line Images. 

You really should have all your images be in line 

with the text.  This means that the screen reader 

will know exactly when to read the alternative text 

for the image.   

Unfortunately, this might not be the prettiest 

option.  For example, if you have a small image, 

there might be a large amount of white space left 

around the in-line image. 

Using Two Columns. 

One way to get around this is to use a two-column 

format for your document.  Using two columns 

makes it easy to put an image in place, as long as 

it is narrow enough the fit within a single column.  

If an image is wider than a column, you will need 

to place a section break within the document 

around the image. 

Creating Two Columns 

To create a two-column document, click on the 

“Layout” tab in the Microsoft Word ribbon.  To the 

left side of the ribbon will be a command icon for 

“Columns”. 

 

You can select one, two, or three columns from the 

dropdown menu.  There are also options for having 

a skinny column to the left or right of a wide 

column.  If none of these choices works for you, 

you can select the “More Columns” option, which 

gives you fine control over the columns. 

 

You can switch the numbers of columns and size of 

columns by breaking your document into sections.  
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Line Spacing 
Blank lines in a document will be read as “Blank” 

by screen readers.  Rather than just adding 

multiple returns, you should make use of page 

breaks and paragraph spacing. 

It is probably best to do this just before publishing 

your document.  Don’t fret about this too much, 

though.  If a student adjusts the font size, the 

page breaks will probably move around. 

Page Breaks. 

To insert a page break, go to the “Layout” tab of 

the Ribbon. 

Click on the “Breaks” option to reveal other 

choices.  A page break ends a page and starts a 

new one.  Other options are here for column 

breaks, and text wrapping.  You can also choose 

from options related to section breaks, including 

next page, continuous (same page), even pages or 

odd pages. 

 

 

Paragraph Spacing. 

Avoid putting blank lines between items.  Instead, 

add spaces before and/or after paragraphs by 

using the line spacing options. 

Select the text you want to modify.  It is best to 

select a full paragraph, but not always absolutely 

necessary. 

Go to the “Home” tab of the Ribbon.  Look for the 

“Paragraph” command group.  There is an icon 

that has an up and down arrow next to four 

horizontal lines.  Click on this to reveal several 

choices.  The one you want is the Line Spacing 

options.  (Choosing Add or Remove Space doesn’t 

give the fine control we want here.) 

 

The Paragraph Option window will open on your 

screen. 

 

I usually modify the spacing option to put 12pt 

after the paragraph.  You can adjust this to the 

size of your default font or a bit bigger.  Screen 

readers don’t see or read this space. 

You can also adjust the spacing around headings 

this way.  
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Publishing Your Document.  

Saving the Document 

Make sure that you save your document in the 

latest format for Word.  Even though there is an 

option to save as a .doc file, you need to save a 

recent document as a .docx file.  This ensures 

compatibility of recent features.  Students or 

schools who are on older versions of Word should 

be encouraged to update. 

Before saving your file for the final time, though, 

makes sure you give your document a title.  Even 

if you’ve used the “Title” style, you still need to do 

one more step. 

Go to the “backstage” view of Word using the “File” 

tab in the ribbon.  At the top of the right-hand 

column, you should see the “Properties” settings. 

This gives you some information about the 

document, including the file size, the number of 

pages, and number of words.  The next item is the 

time you’ve spent editing the document. 

The important thing you must adjust is the “Title” 

of the document.  This is different than the file 

name.  Unfortunately, this doesn’t populate when 

you use the title style.  Click on “Add a title”, then 

type in the title of your document. 

Posting the Original Word Document. 

Posting your document in Word’s .docx format is 

probably the best way to make it accessible to all 

students. 

If a student requires larger text, they can simply 

select all of the document, and then tap up the 

size of the font right from the home screen. 

Word also has the “Speak” function available.  

Newer versions include “Read Aloud” functions and 

Immersive Learning Tools. 

The downside to this is that students can also 

easily change the document unintentionally.  For 

example, they could easily delete an entire section 

of the document. 

For that reason, I like to post my documents twice.  

The first is as a .docx file, the second is as a .pdf 

file. 

Making a .pdf File of your Document. 

There are two ways to make a .pdf copy of your 

document, but only one of those ways will create 

an accessible copy. 

One of the major accessibility features of the .pdf 

format is “tagging”.  This is essentially the proper 

use of heading tags, as well as other tagging 

marks. 

In order to make an accessible .pdf file, you need 

to save the file in the .pdf format.  To do this, click 

on the File menu, select “Save a copy” or “Save 

As…”, and then choose .pdf from the drop-down 

menu.  This creates a tagged .pdf file. 

If you use the other method, “Print as” a .pdf file, 

for some reason the tagging information is lost. 

Always save a copy as a .pdf rather than printing it 

as a .pdf file. 

Having multiple versions of your document can be 

a bit of a pain, especially since it means that you 

need to update in multiple places.  However, the 

inconvenience to you can make the difference to 

your students and audience.  

The Accessible Mindset  
By considering accessibility while creating or 

updating documents, you are helping all students, 

not just those who have a documented disability. 

If your documents aren’t accessible, you set 

yourself up for trouble.  Many educators have been 

thrown into a panic when they receive the notice 

that a student who needs accommodation has 

registered for their class.  This can happen as late 

as a day or two before (or after!) the start of the 

semester. 

At that point, you need to quickly convert all your 

documents into a more accessible form.  You, the 

office of Student Disability Services, and others 

must work quickly to stay in compliance. 

This means that non-experts are forced to work on 

the documents that you, the content expert, have 

created.  This and the time factor can result in 

needless errors. 

By thinking about accessibility proactively, you can 

have most, if not all of your documents ready to 

go.   

If you haven’t started this process yet, start by 

updating a document or two a week this semester.  

Working a document at a time, you can have your 

class updated within a semester or two without 

entering panic mode. 

Another option is to teach a student aid how to do 

this process.  They can process a few documents 

each week, then you can proof-read them before 

posting. 

If you would like me to visit your department or 

school to provide training on making accessible 

documents, please feel free to contact me by email 

at trevor@coachesoftech.com. 

This document is licensed under a Creative 

Commons CC-BY-NC by Trevor Johnson-

Steigelman.  It can be used freely as long as the 

author is listed, and it is not used for commercial 

purposes.  

mailto:trevor@coachesoftech.com
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Appendix:  Useful Links 

http://blogs.wright.edu/learn/accessibility/word/im

ages-in-microsoft-word/  

https://webaim.org/resources/shortcuts/nvda  

http://blogs.wright.edu/learn/accessibility/word/images-in-microsoft-word/
http://blogs.wright.edu/learn/accessibility/word/images-in-microsoft-word/
https://webaim.org/resources/shortcuts/nvda

